GRADUATE COUNCIL: NEW COURSE PROPOSAL
Originating Unit: NEELY (INSC)

Type of action: New course D Full online course**

Semester and year course will take effect: Summer 2023

New course title: Survey of Analytics Technology
Appropriate computer abbreviation (30 spaces or less): Survey of Analytics Technology
Course instructional methodology: | ecture

course component types: ugradcouncil.toia.edu/forms/Course Component Types.pdf

New course number: |[NSC 60120

Prerequisites for new course: include an attachment if additional space is needed
Admitted to Master of Science in Business Analytics program

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments

Clicklhereltolattachlayile



Description of new course (catalog copy): include an attachment if additional space is needed

This course examines contemporary topics in the field of business analytics, which can be broadly
classified as process and tools. Students will be able to explain the lifecycle of analytics from raw data,
feature engineering, model development, model assessment, and model monitoring. The students will
also be able to describe the tech stacks from SQL and other types of databases to extraction tools,
modeling tools, and presentation tools.

Clichiheraonaonsie attached files can be seen and managed in Acrobat Pro by clicking on
. ®© 8 View > Show/Hide > Navigations Panes > Attachments



Fully Online Courses**

All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.
Contact the Koehler Center for Teaching Excellence for guidelines. Include a letter of support from the Koehler Center
with this proposal. " 1t

i Tt

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed
See attached syllabus

——— = — e e —
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attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments

Additional resources required:

Faculty: None
Space: None
Equipment: None
Library: None
Financial Aid: None
Other: none

Change in teaching load: No
Does this change affect any other units of the University? I:I Yes No

If yes, submit supporting statement signed by chair of affected unit.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units. .
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Survey of Technology Analytics, INCS 60120
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Survey of Analytics Technology, INCS 60120

Instructor Name: Kelly Slaughter
Semester and Year: Summer 2023
Number of Credits: 1.5

Class Location: TBD

Class Meeting Day(s) & Time(s): TBD
Office Location: NEEL 3247

Office Hours: TBD

Telephone: 817-257-7540

Email: kelly.slaughter@tcu.edu
Response Time: Replies within 24 hours

Course Description

As a survey course, we will broadly discuss contemporary topics in the field of business
analytics.

These topics can broadly be classified as process and tools. Students will be able to explain the
lifecycle of analytics from raw data, feature engineering, model development, model
assessment, and model monitoring. The students will also be able to describe the tech stacks
from SQL and other types of databases to extraction tools, modeling tools, and presentation
tools.

Throughout the class, students will discuss the WHY and WHETHER. That is, what business
goals are being served that make the analytics effort worthwhile and what are the types of
problems that are amenable to data analysis.

Learning Outcomes

« Explain the lifecycle process of introducing an analytics opportunity to monitoring the
product during use

« Describe the “layers” of technical tools that support the various phases of the analytics
life cycle and how these tools work together

« Understand the business purposes of analytics efforts and the scope of what such
efforts can achieve

Prerequisites

« Entrance into the MSBA program.

Required Texts / Materials

We will not use a book. | will assign articles available over the web: some are free, some will be
available through the TCU online library, and some may require a subscription fee.

Any software tools we use will be open source and free for individual use.
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Instructional Methods

The classes will be primarily hands-on exercises consist of a combination of lectures (mostly
supporting the project and two lectures in support of the prototype development), exercises, and

presentations,

Course Policies and Requirements

Assignmenis

Students will be assigned individual homeworks that will typically involve summarizing articles

and offering class questions.

Final

The students will complete an essay outside of class.

Grading
Final Grade Elements / Grade Breakdown:
Assignments, Exams/Quizzes, Presentations, etc. Points
5 Homeworks (15 points each) 60 points total
Attendance (10 point deduction for each absence) -
Essay 40 points
100 points

Grading Scales

Grade | Score Grade | Score
A |>=94 c >= 74
A- >= 90 c- >=70
B+ |>=87 F <69
B >= 84

B- >= 80

C+ »>=77

©TCU Version 6 (8/22}
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Late Work
Students can turn in homework one day late for half-credit.

Grading Concerns

Type your policy regarding questions about grades.
Feel free to discuss any grading questions and concerns. A request for a grade consideration
should be within a week of the returned grade. The official TCU grade appeal process can be

found at https:/tcu.codes/policies/academic-affairs/qrade-appeal/.

Attendance & Participation

Attendance is extremely important as the work in mostly hands-on.

Class Norms & Netiquette

All members of the class are expected to follow rules of common courtesy in all email
messages, discussions, and chats. If | deem any of them to be inappropriate or offensive, | will
forward the message to the Chair of the department and appropriate action will be taken, not
excluding expulsion from the course. The same rules apply online as they do in person. Be
respectful of other students. Foul discourse will not be tolerated. Please take a moment and
read some basic information about netiguette (http:/www.albion.com/netiguette/).

Participating in the virtual realm, including social media sites and shared-access sites
sometimes used for educational collaborations, should be done with honor and integrity. Please
review the relevant sections of the Student Handbook (htips://deanofstudents.tcu.edu/student-
handbook/) for TCU's network and computing policies and communication guidelines.

Technology Policies .
Email

Only the official TCU student email address will be used for all course notification. It is your
responsibility to check your TCU email on a regular basis.

Course Materials

TCU students are prohibited from sharing any portion of course materials (including videos,
PowerPoint slides, assignments, or notes) with others, including on social media, without written
permission by the course instructor. Accessing, copying, transporting (to another person or
location), modifying, or destroying programs, records, or data belonging to TCU or another user
without authorization, whether such data is in transit or storage, is prohibited. The full policy can
be found at: https://tcu.policytech.com/dotNet/documents/?docid=55&public=true.

Violating this policy is considered a violation of Section 3.2.8 of the Student Code of
Conduct found in the Student Handbook (https:/deanofstudents.tcu.edu/student-handbook/),
and may also constitute Academic Misconduct or Disruptive Classroom Behavior. TCU
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encourages student debate and discourse; accordingly, TCU generally interprets and applies its
policies, including the policies referenced above, consistent with the values of free expression
and First Amendment principles.

Academic Misconduct

Academic Misconduct (Section 3.4 of the Student Code of Conduct found in the Student
Handbook (https://deanocfstudents.tcu.edu/student-handbook/)): Any act that violates the
academic integrity of the institution is considered academic misconduct. The definitions and
procedures used to resolve suspected acts of academic misconduct are availabie in the offices
of the Academic Deans and Dean of Students, and are also listed in detail in the Undergraduate
Catalog (http:/tcu.smartcatalogig.com/current/Undergraduate-Catalog/Student-
Policies/Academic-Conduct-Policy-Details) and the Graduate Catalog
{http://tcu.smartcatalogiq.com/en/current/Graduate-Catalog/Academic-Conduct).

Specific examples include, but are not limited to:

» Cheating: Copying from another student's test paper, laboratory report, other report, or
computer files and listings; using, during any academic exercise, material and/or devices
not authorized by the person in charge of the test; collaborating with or seeking aid from
another student during a test or laboratory without permission; knowingly using, buying,
selling, stealing, transporting, or soliciting in its entirety or in part, the contents of a test
or other assignment unauthorized for release; substituting for another student or
permitting another student to substitute for oneself,

» Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s
work, and the unacknowledged submission or incorporation of that work as one’s own
offered for credit. Appropriation includes the quoting or paraphrasing of another's work
without giving proper credit. [If you are using Turnitin, place information about your
course ID/password or state that items will be checked as part of the TCU Online
assignment submission process. If you want to use Turnitin as a spot check, indicate
that you may use Turnitin for plagiarism detection.]

» Collusion: The unauthorized collaboration with another in preparing work offered for
credit,

» Abuse of resource materials: Mutilating, destroying, concealing, or stealing such
material.

.» Computer misuse: Unauthorized or illegal use of computer software or hardware
through the TCU Computer Center or through any programs, terminals, or freestanding
computers owned, leased or operated by TCU or any of its academic units for the
purpose of affecting the academic standing of a student,

» Fabrication and falsification: Unauthorized alteration or invention of any information or

- citation in an academic exercise. Falsification involves altering information for use in any
academic exercise. Fabrication involves inventing or counterfeiting information for use in
any academic exercise.

» Multiple submission: The submission by the same individual of substantial portions of
the same academic work (including oral reports) for credit more than once in the same
or another class without authorization.

« Complicity in academic misconduct: Helping another to commit an act of academic

. misconduct.

« Bearing false witness: Knowingly and falsely accusing another student of academic

misconduct.
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TCU Online: Our Learning Management System

Getting Started with TCU Online

Technical Requirements: Check your computer is ready by locking at the specifications list.
(hitps./community.brightspace.com/s/article/Brightspace-Platform-Requirements)

Log In: (using your TCU Network Credentials)
Option 1: Access via my.tcu.edu > Student Quick Links > TCU Online
Option 2: Login at htip://d2].tcu.edu

*For information about logging into TCU Online, view these instructions
(http:/ftcuonline.tcu.edu/kb/how-do-i-log-in/).

Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online
Student Orientation Tutorial, please do so now. To access it, click on the Orientations semester
OR view all courses in your My Courses widget visible upon logging in to TCU Online. Click on
the "Student Orientation Tutorial” to enter the orientation course. Follow the instructions in the
course. You can return to this tutorial at any time.

How This Course Will Use TCU Online

We will not meet online unless compelled to do so.

Getting Help with TCU Online

If you experience any technical problems while using TCU Online, please do not hesitate to
contact the D2L HELP DESK. They can be reached by phone or chat 24 hours a day, 7 days a
week, 365 days a year.

Phone: 1-877-325-7778
Chat: Chat is available within TGU Online in the Help menu on the navigation bar.

If you are working with the helpdesk to resolve a technical issue, make sure to keep me updated
on the troubieshooting progress.

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please
contact me.

Personal Settings'& Notifications for TCU Online

As a student, you should set up your account settings, profile, and notifications. To do this you
will login to TCU Online and select your name on the top right of the screen. You can upload a
photo of yourself and add personal information to your profile. In the notifications area, you can
add your phone number to receive text messages when grades are given, as well as reminder
texts for upcoming assignments and quizzes.
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Student Success Tools for TCU Online

Pulse

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and
announcements. This app provides a graph that can help you manage your time. Based on the
number of assignments and events on the course calendar for your classes, the graph will
display busy times for class work in the upcoming week. You can use this app to manage your
daily workload, and it includes the ability to view and access course materials offfine. You can
download Pulse from the Google Play or Apple Store. You can learn more and download Pulse
here: hitps://www.d2l.com/products/pulse/.

[Pulse is a management tool for students to easily access information about the course from a
mobile device. For Pulse to work well with a class, you should use the calendar tool in TCU
Online. It is very important to use the course calendar due date function for readings,
assignments, quizzes, and discussions in order to help populate the calendar used in Pulse.]

ReadSpeaker

ReadSpeaker includes a number of tools that can enhance your understanding and
comprehension of course materials. ReadSpeaker can create an audio version of content that
you can listen to while on a page within a course or that you can download to listen offline.
ReadSpeaker can also read Microsoft Office files and PDFs. There are additional tools and
features to assist you with reading and focusing in TCU Online, tools that provide support for
writing and proofing text, and tools that can read non-TCU Online content aloud. You can learn
more about how to use ReadSpeaker tools here: https://tcuonline.tcu.edu/how-to-hub/instructor-
how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/

]

Support for TCU Students

Campus Offices

¢ Academic Advising (817-257-7486, Jarvis 104)
s Brown-Lupton Health Center (817-257-7938 or 817-257-7940)
+ Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003)
» Center for Writing (817-257-7221, Reed Hall 419)

~» Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2™ floor)
¢ Dean of Students (817-257-7926, the Harrison 1600)
e Mary Couts Burnett Library: Reference Desk (817-257-7117)
o Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1% floor)
¢ Student Access & Accommodations (817-257-6567, The Harrison 1200)
e Student Success (817-257-8345, Samuelson Hall, West Entrance)

~» Substance Use and Recovery Services (817-257-7100, Jarvis Hall 27 floor)
e Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)
» Veterans Services (817-257-5551, Jarvis Hall 2" floor)
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Anti-Discrimination and Title IX Information
Statement on TCU’s Non-Discrimination Policy

TCU is committed to providing a positive learning, living, and working environment free from
unlawful discrimination, harassment, sexual misconduct, and retaliation. In support of this
commitment, in its policy on Prohibited Discrimination, harassment, sexual misconduct and
retaliation, TCU has a range of prohibited behaviors, including unlawful discrimination and
harassment and related sexual and other misconduct based on age, race, color, religion, sex,
sexual orientation, gender, gender identity, gender expression, national origin, ethnic origin,
disability, predisposing genetic information, covered veteran status, and any other basis
protected by law. The Office of Institutional Equity (OIE) is responsible for responding to
all reports of discrimination, harassment, sexual misconduct and retaliation.

Please use the following links to review TCU Policy 1.008 Prohibited Discrimination, Harassment,
Sexual Misconduct and Retaliation or to review TCU Policy 1.009 Responding to Reports of
Prohibited Discrimination, Harassment, Sexual Misconduct, and Retaliation.

To make a report, you may call OIE at 817-257-8228, email oie@tcu.edu, visit us at The
Harrison, Suite 1800 or click here: Make a Report.

To learn about the Campus Community Resl:_)dnse Team (CCRT) and Report a Bias Incident click

here: https://inclusion.tcu.edu/campus-community-response-team

Title IX

TCU’s Title IX Coordinator works within OIE. Andrea Vircks-McDew serves as TCU’s Title IX
Coordinator. You may call 817-257-8228 to make a report, email cie@tcu.edu or

a.vircks@tcu.edu, or make a report here. Additional Title IX resources and information are
available at https://www.tcu.edu/institutional-equi

Mandatory Reporters

ALL TCU employees, except confidential resources, are considered Mandatory Reporters.
Mandatory reporters are required to immediately report to OIE any conduct that raises
Discrimination, Harassment, Sexual Misconduct (Title IX or Violence Against Women (VAWA)) or
Retaliation. Mandatory reporters cannot promise to refrain from forwarding the information to
OIE.

Confidential On-Campus Resources
Campus Advocacy, Resources & Education

https://care.tcu.edu | 817-257-5225

Counseling & Mental Health Center
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www.counse]ing.tcu.edu' | 817-257-7863

Religious & Spiritual Life
www.faith.tcu.edu | 817-257-7830

On Campus Resources
TCU Paolice
www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency

TCU Policy for Religious Observations & Holidays

“Students who are unable to participate in a class, in any related assignment or in a university
required activity because of the religious observance of a holy day shall be provided with a
reasonable opportunity to make up the examination or assignment, without penalty, provided
that it does not create an unreasonable burden on the University.” For more information, please
visit the TCU Policy for Religious Observations & Holidays webpage.

Student Access and Accommodation

Texas Christian University affords students with disabilities reasonable accommodations in
accordance with the Americans with Disabilities Act and Section 504 of the Rehabilitation Act.
To be eligible for disability-related academic accommodations, students are required to register
with the TCU Office of Student Access and Accommodation and have their requested
accommodations evaluated. If approved for accommodations, students are required to discuss
their official TCU Notification of Accommodation with their instructors. Accommodations are not
retroactive and require advance notice to implement. The Office of Student Access and
Accommodation is located in The Harrison, Suite 1200. More information on how to apply for
accommodations can be found at https://www.tcu.edu/access-accommodation/ or by calling
Student Access and Accommodation at (817) 257-6567.

Audio Recording Notification:

Audio recordings of clasé lectures may be permitted by the instructor or as an approved
disability accommodation through Student Access and Accommodation. Recordings are not to
be shared with other students, posted to any online forum, or otherwise disseminated.

Emergency Response Information
View TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate, and Seek

Shelter procedures. (https:/publicsafety.tcu.edu/less-is-more/)

View the TCU Building Safety Maps that show the specific seek shelter locations and building
rally points for evacuation. (https:/publicsafety.tcu.edu/less-safety-maps/)

View the TCU Evacuation Rally Point Map to see all rally points for evacuation.
(https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf)
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Download the Frogshield Campus Safety App on your phone. (https:/police.tcu.edu/frogshield/).

In the event of an emergency, call the TCU Police Department at 817-257-7777.
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Course Schedule

This calendar represents my current plans and objectives. As we go through the semester,
those plans may need to change to enhance the class learning opportunities. Such changes will
be clearly communicated.

Date Topic

Day 1 Overview . =

Day2 Process: from opportunity recognition to feature enginesting
Day 3 Process: from modéi déﬁelbpfne‘ntftd ma‘i;nf‘sa_a'_.n:ance

Day 4 Stack: The storage and manipulation of data

Day 5 Stack: ‘I%h'e- modeling, 'ﬁresenfation, arid rﬁo‘riitoring df models

Student Perception of Teaching (SPOT)

Towards the end of the term you will receive an email asking you to complete your SPOT for
this course. | appreciate your thoughtful and reflective feedback to help make this course
successful for future students. You can fill out the SPOT by clicking on the link in the email or in
TCU Online when SPOTSs open.

TCU Mission Statement

To educate individuals to think and act as ethical leaders and responsible citizens in the global
community.
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